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[bookmark: _Toc272101569]Preface

NOTE:  This document is in DRAFT form and is expected to have errors.  During this time, please direct all comments to the author.

This documentation supplements and in some cases expands on the Opticks documentation found on the Help menu and online at the Opticks site.  The intent of this documentation is to provide the user with a logical overview of the application as well as some additional commentary on the tools, their use, and how they are used in for a particular purpose (e.g. identifying a particular cover type or material in an image requires a series of steps and a number of tools to complete the task).

The Opticks User Guide begins with a general overview of the application, getting it set up and being able to load an image and becoming familiar with some of the tools and how to interact with the application interface.  The Opticks site provides a much more detailed explanation of the tools.  This document will explain the use of many of the tools as an analyst works through common and realistic image processing tasks as they relate to remotely sensed imagery.

Users are encouraged to refer to both this document as well as the Opticks Help as needed to complete tasks.  Please submit comments, questions, and issues to one of the following:

nate@jenningsplanet.com
jenninn@arc.losrios.edu
users@opticks.ballforge.net (free registration is required to post comments to the Opticks forum)

The user forum email can be found on the Opticks page under the Community section of the home page.

http://opticks.org
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[bookmark: _Toc272101571]Opticks – Getting Started

See Help menu for a comprehensive explanation of the Opticks, toolbars, function descriptions and basic tutorial guides.  Most of these can orient the user with Opticks functionality.   Make sure to download the sample data sets or use images provided by the instructor.


[bookmark: _Toc272101572]Setting up the Opticks Environment

If Opticks is installed on a personal or standalone system, the default settings will likely be sufficient to perform the Opticks functions.  If Opticks is used in a lab where the user does not have write access to all of the default Opticks file paths, the following settings will need to be changed.  If the same user uses different computers, the settings may need to be set for each new user/machine.

Using Opticks in a multi-user lab environment, the default options for Opticks may need to be changed.  The Options are found under Tools—Options.  Some folders may need changing If users do not have write access to the default locations.  Users should check with a technology administrator to make sure the proper access to system folders is available.
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The following paths can be changed and set by the user to provide locations where users have read/write access.  Normally, the paths only need to be changed once; however, in some lab configurations, specific users may need to make the same changes if different machines are used.

For the Session—File Locations change the paths below as needed.  Write permission may be required for some locations.
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[bookmark: _Toc272101573]Loading Custom Plug-ins (Opticks Extensions)

Plug-ins are additional code packages that extend the core functionality of Opticks.  These are custom built applications developed in C++ by the Opticks open source community and delivered as either compiled dynamic link libraries (DLLs) or from compressed files (AEB – similar to the zip format).  A few plug-ins exist for Opticks (Spectral Processing, Python, RADAR, and SAR (Synthetic Aperture RADAR) that are not part of the core functionality of Opticks.  Before downloading and installing plug-ins make not of the installed Opticks version and the Plug-ins version number.  Plug-ins support specific versions of Opticks.  Some plug-in versions are not forward or backward compatible.  The Opticks Extension site will indicate which Opticks version is supported.

Three methods exist to load extensions.

1. Install Extensions for the Help menu.  Once the AEB files are downloaded, users can install the extensions by going to the help menu and choosing install.  The installed extensions will show up under the help menu.
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2. Drag/Drop AEB onto Opticks.  Users can download the extensions from the Opticks site and simply drag and drop the AEB extension into any location on Opticks when the application is open.  The AEB will extract and load in the proper location for Opticks to recognize it.

When AEB files are installed, users will see the installed extensions under the Help menu.

3. Copy DLL file to Opticks Plug-in directory. Download and open the zip file containing the DLL file from the Opticks extension site.  Copy the DLL file the C:\Program Files\Opticks\<Opticks version>\Plug-ins folder.  When Opticks is open, typically a new toolbar will appear in the Session Explorer.  Also, the user will see the DLL file show up in the Plug-ins Tab. 

[image: ]Drag and Drop AEB files here from Windows Explorer.
The DLL files automatically install.
The DLL files that are installed show up here

In either case, the user can check the respective Toolbar from the Session Explorer to load the toolbar if one exists for the plugin.  Make sure to read any documentation that accompanies the plug in.

[bookmark: _Toc272101574]Saving an Opticks Session

To save an Opticks Session (similar to a project file), the user can choose File—Save Session As (or Save Session if an Opticks Session already exists) and assign a session name.  The Opticks Sessions will have an extension of .Session and an Opticks Session folder (.SessionDir) will be created in Windows Explorer.  The SessionDir contains a number of files that keep track of imagery and settings used in the respective session.  Image files do not have to be stored in the same directory as the Opticks Session.
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[bookmark: _Toc272101575]Customizing Opticks Options

The user can also make modifications to some of the Options within Opticks such as units, colors, and custom band combinations.

[bookmark: _Toc272101576]Creating a Custom Band Combination

1. Under the Tools—Options menu, select Raster under the Layers Options.
[image: ]

2. Click on the Add button on the Color Composites portion of the Options window.

3. Make the following changes by highlighting on each element to rename the New Composite and assign band combinations.  If wavelengths are known, these can also be added if necessary.
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[bookmark: _Toc272101577]Using the New Band Combination

When users import or display imagery, this new color composite will be available.

[bookmark: _Toc272101578]Displaying Toolbars

Tool bars for Opticks are usually displayed at the top of the application.  Additional Toolbars can be added by doing the following:

1.  Click on the Toolbars menu in the Session Explorer
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2.  Check the respective box to display the toolbar


[bookmark: _Toc272101579]Toolbar Overview

This section provides a brief overview of each Opticks Toolbar (checked below).  Unchecked toolbars are not covered in this document.  See the Help menu for more details on the tool.   Other sections in this guide will have additional details on respective tools as they are discussed.  Some toolbars are not activated until an image or other feature is loaded into Opticks.  Hover the mouse over a specific tool to see the name of the tool.  Also, look at the lower left corner of the Opticks Application window to see a short description of the tool.
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The AOI (Area of Interest) tool allows the user to create small areas on the image to perform additional operations such as create subsets, limit processing areas, and work with spectral signatures.  An AOI layer must be created or exist to activate the toolbar.
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[bookmark: _Toc272101581]Annotation

The Annotation Toolbar used to add text, and other information to the image display for a simple map to be produced.  An annotation layer must be created or exist to activate the toolbar.
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[bookmark: _Toc272101582]Brightness

The Brightness toolbar allows the brightness and contrast of the current image window to change.  An image must be loaded into the image viewer to activate this toolbar.

[image: ]

[bookmark: _Toc272101583]Display

The display toolbar provides the primary navigation functions for zoom in/out/full extent, pan, and various image rotation options.
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[bookmark: _Toc272101584]General Algorithms

The General Algorithms provide some basic image manipulation options.  An image must be loaded to operate many of the functions within this toolbar.
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[bookmark: _Toc272101585]Band Math

Provides options to perform basic math functions between different image bands (e.g. addition, subtractions, divide (band ratios), multiply, etc).
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[bookmark: _Toc272101586]Change Up Direction

This function allows the user to change the up direction to always be at the top of the image.  For example, if a satellite has a southern orbital path, the southern part of an image may be at the top and appear “upside down.”  Users can change this direction if required.

[bookmark: _Toc272101587]Data Fusion

This function allows for two different images to be combined into a single image space or to integrate higher resolution imagery with lower resolution imagery.

[bookmark: _Toc272101588]Flatten Annotation Layer

This option is not yet documented.

[bookmark: _Toc272101589]Principle Component Analysis

This function runs a principle component analysis routine.  Principle Components often is used to reduce the number of bands required for image processing as well as performing some change detection operations.  Consult a Remote Sensing textbook for more details.

[bookmark: _Toc272101590]QT Cluster

This option is not yet documented.

[bookmark: _Toc272101591]Geo

The Geo Toolbar provides the ability to assign a georeference (coordinate system) to the image.  Georeferencing is discussed in more details below.  Images must have a related set of ground control (GCPs) for the georeference to be assigned.   The toolbar provides some basic ability to add GCPs.  Latitude/Longitude, UTM, and MGRS (Military Grid Reference System) coordinate systems are supported.

[image: ]

Geographic Features

The Geographic Features toolbar provides the ability to load GIS shapefiles or geodatabases (including ArcSDE enterprise grade geodatabases).

[image: ]

[bookmark: _Toc272101592]Measurement

The Measurement Toolbar allows measurements to be made and displayed on the image.  An image must be loaded and georeferenced to use this toolbar.  Also the Measurement Mode button must be clicked.

[image: ]

[bookmark: _Toc272101593]Spectral

The Spectral Toolbar provides several algorithms for processing hyperspectral data and creating spectral signatures for identifying different materials from hyperspectral (or other imagery).  The Spectral Signature capability is provided by the Spectral Processing Extension.   An image must be loaded into the viewer and some functions require the spectral values to be represented as percent reflectance as well as know the specific wavelengths for each band.  Often hyperspectral data is provided with percent reflectance whereas other non-hyperspectral imagery is represented with a brightness value relative to the materials reflectance.  Specific functions on the spectral toolbar are discussed in the Hyperspectral section. 
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[bookmark: _Toc272101594]Standard

The Standard Toolbar provides the ability to open or import a variety of image and vector data types.  A link is also provided to access the Opticks Help.

[image: ]

[bookmark: _Toc272101595]Tie Point

The Tie Point Toolbar provides some ability to collect additional points in image data so that some basic image rectification can be performed.

[image: ]

[bookmark: _Toc272101596]Toolbox

The Toolbox Toolbar is another primary toolbar that is used often in Opticks.  It provides the capability to view histograms of image bands, loads the Session Explorer, load a scripting window to run custom scripts, create image subsets (image chips), link image viewers, and activate the layer edit mode that activates the AOI tools

[image: ]

[bookmark: _Toc272101597]Working with Imagery in Opticks

To use Opticks, image data must be loaded into the application.  This can be achieved by going to File—Import Data and then search for image data or the Import Tool (Open Folder button) on the Standard Toolbar.  Since a variety of imagery can be loaded (panchromatic  [i.e. single band black and white], true color, multi-spectral, or hyperspectral), it can be loaded and viewed either as a single band image or 3 of the multi-spectral or hyperspectral data can be assigned to the RGB colors of the color display.  By default, multi-spectral data not already saved into an Opticks session will display as black and white.  The user will need to change the display to assign specific bands or wavelengths to the RGB color display.

Opticks supports a number of raw and common file remote sensing image formats.  Some are sensor specific, while others are in common delivered format (TIF, ERDAS Imagine, ENVI, NITF, HDR).  Opticks has its own image format called ICE (Image Cube).  Data can be saved and exported to this format.  Other image processing software may not be able to read this format.  It is recommended to save data to a more common format (e.g. TIF).

[bookmark: _Toc272101598]Display an Image

Click on the Import Data Tool

[image: ]

Select the specific file format and location of the file.

[image: ]Choose the appropriate file format.
Common formats are: GeoTIFF (TIF), BSQ, BIP, BIL, ERDAS Imagine, ENVI, HDR, NITF)


The Options button brings up an additional dialog box that allows the user to select specific bands of the image and assign them to RGB display colors, otherwise, the image will display as a grayscale image (the default).

[image: ]RGB display colors can be assigned to specific sensor bands.  The Display mode can also be set to RGB to display color.
NOTE:  Display mode must be set to RGB to see the color assignment.


The user can change the band combination at any time by bringing up the image properties from the Session Window and then right click on the image file.

[bookmark: _Toc272101599]Image Properties

[image: ]	Right click on the image and then select Properties to bring up the image properties.


Band assignments, display mode, and image stretch can be changed in the image properties dialog box.
[image: ]

If the all of the display bands indicate the same band number, then the image will display in grayscale (black and white), even if the image is multi-band.  


[bookmark: _Toc272101600]Reviewing Metadata about the Image

Information about an image can be viewed at the time of import or loading into Opticks or through the Elements Tab in the Session Window.

[image: ]Right click on the image, and select properties to view metadata


Refer to the Data Elements Properties in the Opticks Help for additional information.

[bookmark: _Toc272101601]Data Tab

This tab shows the basic information about the image (bands, rows, columns, data type, pixel size, etc.).
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[bookmark: _Toc272101602]File Tab

This tab also contains much of the same information found in the Data Tab and also contains any ground control points (GCPs) that is used to place the imagery in geographic space.
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[bookmark: _Toc272101603]Metadata Tab

The metadata tab provides information about the wavelengths that are used in the current display.

[image: ]

[bookmark: _Toc272101604]Wavelengths Tab

The wavelengths tab provides information about the specific wavelengths for each band in the full image file.  The wavelegnths can be displayed in micrson, nanometers, or inverse centimeters.

[image: ]



[bookmark: _Toc272101605]Subset an Image

Users may not want to import an entire image into Opticks, especially if the image is very large (> 1 Gb) or I there are a large number of bands and some are known to not contain very useful information (such as hyperspectral data with the water vapor absorption bands removed).  Two options are available to limit the number of bands and spatial extent of the image during import.  See the Opticks Tutorial on Spectral and Spatial Subset for additional details.
	
[bookmark: _Toc272101606]Band Subset

An easy way to subset an image containing a smaller number of bands than the original is to select (or ignore) bands from the input image using the Options button on the Import dialog box.

[image: ]

[image: ]Choose the bands to import.  Unselected bands are not imported.


Notice that the imported image shows 3 bands

[image: ]

The imported file still indicates 6 bands in the original image file.

[image: ]

If the remaining defaults are chosen, then the image will display as gray scale.  The user can use methods described above to change the band combination and to display the image as RGB (i.e. as a color display).

[bookmark: _Toc272101607]Spatially Subset Image

In addition to the above, the user can also limit the spatial extent of the image by using the Preview button in the Import window.

[image: ]

Use the tool provided to select a rectangular area to subset the image by the extent of the rectangle.  Using this method in addition to the Band Subset can limit both the number of bands and the spatial extent of the imported image at the same time.

[image: ]
After the image is imported, the following viewer appears with the both the number of bands and the spatial extents reduced.

[image: ]

If the user changes the band combination, the new imported file may look like this.

[image: ]



[bookmark: _Toc272101608]Working with Histograms

Histograms are graphical representations of data.  In the case of remotely sensed imagery histograms represent the distribution of pixel values for a given spectral band.  Opticks can display histograms for spectral bands.  The values along the X axis may represent the brightness range (intensity levels) of an image and the Y axis represents the total count for a given brightness value.  For more information see the Opticks Help under Opticks Studio—Working with Opticks Windows—Histogram Window.

[bookmark: _Toc272101609]Viewing a Histogram

To view the histogram for a band of the active image viewer, click on the Histogram tool on the Toolbox toolbar. 

[image: ]

Alternatively, the user can expand the Dock Windows element under the Session Explorer, and then expand the respective image.   Check the box for the Histogram Window to display the histogram for the active image.

[image: ]

The Histogram tools loads a graphic display for one or more of the bands in the active image.  If the user has only a gray scale image displayed a single histogram shows up like this.


[image: ]

If the image is a multiband image the user can right click in the Histogram Window and choose the Displayed Band.  Select a different band to change the histogram.

[image: ]Choose a different band to change the histogram


If a multiband image is displayed as color a histogram is displayed like this.

[image: ]

Notice the three tabs at the bottom of the histogram indicating the Red, Green, and Blue bands.  When each color tab is clicked, the respective histogram is displayed.  Notice the Band number at the top of the Histogram Window.  Users can change the band assignment for a given color by right clicking in the Histogram Window and change the Displayed Band as described above.  The displayed window will also change.

[bookmark: _Toc272101610]Changing the Contrast

Users can also change the stretch of the active image by left-clicking (or left-click hold and drag) on the left or right side of the colored area in the Histogram Window.  The image will change in contrast.

[bookmark: _Toc272101611]Changing the Image Stretch

Different kinds of image stretches can also be applied to the image by using the Histogram Window.  Applying an image stretch to an image can enhance different areas within an image.  A typical image stretch for remotely sensed image is a two standard deviation stretch following a linear function.  Different types of image stretches and units can be used per band while using the Histogram Window.  Right-click in the Histogram window to access these options.

[image: ]

Linear – typically the default stretch and follows a linear function.  The data is stretched in a linear fashion from low values to high values and tends to apply a stretch evenly across the image.

Exponential – follows an exponential curve.  This stretch tends to suppress darker areas and enhance brighter areas.

Logarithmic – follows a logarithmic curve.  This stretch tends to suppress brighter values and enhance darker values.

Histogram Equalization – this stretch attempts to place an equal number of pixels to a specific number of spectral categories across the brightness range.  The effect of this stretch tends to make the brighter areas just a little brighter and the darker areas just a little darker.  The brighter areas can look a little more washed out. 

An image stretch can also be changed by right-clicking on the image file in the Session Explorer.

[image: ]

The stretch units can also be changed.

[image: ]




[bookmark: _Toc272101612]Appendix A – Creating and Using Wizards

Wizards

Wizards in Opticks allow the user to develop and create a process (i.e. a workflow or model) and then can reuse it for different inputs and outputs.  Wizards can assist with improving productivity of repetitive tasks and can also add functionality to Opticks without requiring any special programming skills.  Wizards can be executed in various ways such as within the Wizard Builder, from a custom toolbar and menu list, or externally by running a command or batch file.

Using Wizards for Common Tasks

Some Image processing tasks that are not part of the core Opticks functionality are good options for creating a wizard.  One such example is the creating band ratios using the Band Math Tool.  Ratios can be computed using the Band Math Tool, but this is typically a single operation and the user cannot save the math expression without copying and saving it to an external file.  This can be cumbersome since the expression can be complex.  One alternative to expanding the flexibility of the Band Math Tool is to incorporate it into a custom wizard where the user can develop the algorithm one time and then reuse it for different kinds of images.

Building a Wizard

To create a custom wizard, the Wizard Builder is used.  The Wizard Builder is started from Tools—Wizard Builder.  The Wizard Builder is displayed.

[image: ]Wizard Builder Canvas (Processing objects go here)
Wizard and Object Execution Mode
Wizard Menu Location
Processing objects and groups of objects


A set of processing objects are displayed on the left side.  These are used to build the model and show up in the middle section.  The right side of the Wizard Builder is used to determine how a process will be executed (interactive through user input or batch mode for automating tasks) as well as changing the order of objects and indicating if a custom toolbar will be created with menu options to run the wizard.

An example of a simple model is shown below.

[image: ]

This model shows the Band Math Tool as well as a Get Raster Element object to solicit an image file that is already open in Opticks as well as the actual math expression (e.g. NDVI) that the Band Math Tool uses.  The model also includes objects to solicit an output file name from the user and the file will be exported using the TIF format.  

The Execution Mode (upper right) is set to Interactive indicating the tool will require some user input to run to the tool.  If the execution mode was set to Batch, the user would click the menu option (or the Execute button in the Wizard) and the process would run without user interaction.  Notice on the upper right that a menu location has been set to:

[Ratios]/NDVI

This structure indicates that a tool bar called “Ratios” will be used and /NDVI indicates a menu option under the Ratio tool bar.  

NOTE:  For Opticks to properly use the custom toolbars the Wizard Path must be set and the wizard files must reside in this folder.  Below, the Wizard Path is set to C:\temp, but this can be changed by the user under Tools—Options.


[image: ]


The processing objects above are numbered indicating the order in which they are used.  The first object is the Get Raster Element.  The Get Raster Element allows the user to choose an existing file that has been imported into Opticks.  Alternatively, Import Data Set (i.e. an input file that is not currently displayed in Opticks and solicited from the user by making the object Interactive) can be used.  If the image already is open in Opticks, the user will be shown a message that the image is already loaded.  The second object is the math expression.   Both objects are required to run the Band Math Tool (third object), since the Band Math tool requires an image (i.e. an image cube) and an expression for the tool to operate.

Also note the different colored outlines on the objects.  

1. Black indicates an interactive object (one that requires user input)
2. Red indicates batch mode (that does not require user input)

Each object in the Wizard Builder can have different modes of operation similar to that of the entire model.  In the example above, two interactive objects exist:  

1) the input file (Get Raster Element)
2) the Output File name (a name provided by the user and will have the TIF extension)

Four batch objects exist in the model and will not have any user interaction:  

1) the math expression 
2) the actual processing of the math expressions through the use of the Band Math Tool
3) create File Export Description (this sets up the export function to tell Opticks an output file will be generated
4) the kind of exporter (in this case a GeoTIFF export type)

The inputs to the model are:

1. Input Raster (already opened within Opticks)
2. Math expression
3. Band Math Tool
The outputs to the model are:

1. Output GeoTIFF that requires:

1. File name
2. Export descriptor

Note that the Band Math Tool has two green lines, one going to the Export File Descriptor and one going to the GeoTIFF Exporter.  Both the Export File Descriptor and GeoTIFF Exporter need to know that an image file, in this case the output raster of the Band Math Tool.  The Export File Descriptor is connected to the GeoTIFF Exporter so that the GeoTIFF Exporter knows the specific kind of export file to create.

The exact same structure can be used for any Band Math function, with these changes:

1. The specific math function
2. The output filename 

Alternatively, the user can modify the model to also solicit any valid input file, provided it is not already imported into Opticks.

In the model above, the user can choose to not write (save) an output file and the output from the Band Math Tool will appear in a new window in Opticks.  The user can save the image at a later time.

Updating the Wizard List

Before Opticks is aware of any new changes to a Wizard or Wizard Toolbar, the Update Wizard List menu option must be checked to refresh the Wizard List (Tools—Update Wizard List).

The following ratios were added as part of the “Ratios” toolbar. 

[image: ]

Each of the specific ratios is a separate Wizard (.wiz files) although they all show up under the Ratios toolbar because they have the same [Ratios] toolbar placement and all of the .wiz files exist in the same directory (set by the Wizard Path under Options).

The ratios are common to Landsat TM.  Additional ratios can easily be added and other menu options created for different sensors.
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